==RATINET
Overview

This guide describes how to use Windows utilities to identify suspicious sample files and send them to the AVLab at
Fortinet. The AVLab can further analyze the suspicious sample file, and provide you with the most appropriate solution.

When files are infected with ransomware, it is almost always impossible to reliably restore the

Y affected files. After a device has been victim to a successful or undetected Zero Day infection
‘9' orintrusion, it is highly recommended to restore the entire affected system from a clean
|| backup. It is nearly impossible without proper forensic procedures to determine whether other

components might have been installed during the breach because successfully executed
malware can download and install additional components from a remote site.

It is highly recommend to obtain the third-party tools referenced in this guide from the Microsoft Sysinternals site at
https://docs.microsoft.com/en-us/sysinternals/.

vy
‘?' The third-party tools referenced in this guide have been tested on a device running a Windows
- 10 operating system.

This guide contains the following topics:

« Installing and using Process Explorer to locate suspicious files on page 1

« Installing and using Process Monitor to locate suspicious files on page 3

« Installing and using Autoruns to locate suspicious files on page 5

« Revealing hidden, suspicious files on page 7

» Ending tasks or killing running processes to enable copying of suspicious files on page 8

Installing and using Process Explorer to locate suspicious files

You can use the Process Explorer utility to view currently running processes on a host. Process Explorer is similar to
Task Manager, but provides more detail about the current running process.

Process Explorer can be used to search for and locate suspicious files. A suspicious process can be any processes that
are unfamiliar to you or your system administrator. The process name often indicates the name of the running
application. You can consider any unfamiliar processes or applications suspicious.

To install Process Explorer:

1. Download the Process Explorer utility from Microsoft at https://docs.microsoft.com/en-
us/sysinternals/downloads/process-explorer.

2. Install Process Explorer.
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To use Process Explorer:

1. Open the Process Explorer utility, and search for suspicious processes.

2. If you cannot determine whether processes are suspicious, save the list of processes to a text file, and send the file
to the AVLab:

a. InProcess Explorer, select File > Save As, and save the file as a .txt file.

A ¥ Process Explorer - Sysinternals: www.sysinternals,com [DESKTOP-MR3KC 7T\ ResearchDept]
im File Options View Process Find Users Help
Run... CtrleR B | |_| |—| | |
- Run as .ﬁ.dn_-ninistratur... e B S& PID Description ¢
I Run as Limited User... 4968 K 27900 K 52
®  Show Details for All Processes 60K 8K 0
216K 9684 K 4
Save Ctrl+5S 0K 0K n/a Hardware Intemupts and DPCs
1,076 K 536K 384
5196 K 23N 36K 1700
Shutdown r 1500 K 2880K 47
Exit 2064 K 3564K 552
R e 1336 K 2180K 572
=) W services exe 5260 K BOODK 688
= [a=|swchost exe 17420 K 23072K 816 Host Process for Windows 5... M
28,188 K
7463 K
Susp... 102,868 K
CPU Usage: 1.54% Commit Charge: 84.61% Processes: 144 Physical Usage: 61.26%

M_n fest.ixt - Notepad
Susp.| File Edit Format View Help
|Process CPU Private Bytes Working Set PID Description
Registry 4,732 K 28,0892 K 92
System Idle Process 95.51 68 K 8 K e
System < 90.81 216 K 9,680 K 4
Sl Interrupts < 9.81 @K 8K nfa Hardware Interrupts and
SMSS5.exe 1,876 K 536 K 384
Memory Compression 5,168 K 2,354,516 K 1788
CSrss.exe 1,980 K 2,876 K 476
CSMSS . exXe < @8.81 2,116 K 3,596 K 552
wininit.exe 1,336 K 2,188 K 572
services.exe 5,312 K 8,012 K 638
svchost.exe 17,364 K 28,060 K 216 Host Pr
StartMenuExperienceHost.exe 28,216 K 53,448 K
RuntimeBroker.exe 7,556 K 28,888 K 60832 Runtime
Coarrhfinn avao SCncnandad 107 BRR ¥ 71 A98 ¥

b. Attach the log text file to the FortiCare ticket.
c. Skip the last step in this procedure.

3. Ifyou locate a suspicious process, use the Process Monitor utility to further analyze the file. See Installing and using
Process Monitor to locate suspicious files on page 3.
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Installing and using Process Monitor to locate suspicious files

You can use the Process Monitor utility to monitor in any registry, process, or thread activity in real-time.

If you locate a potentially suspicious process by using the Process Explorer utility, you can use the Process Monitor
utility to further analyzer the suspicious process.

To install Process Monitor:

1. Download the Process Monitor utility from Microsoft at https://docs.microsoft.com/en-
us/sysinternals/downloads/procmon.

2. |Install Process Monitor.

To use Process Monitor:

1. Open the Process Monitor utility.
2. Goto Filter > Filter.
BN Process Menitor - Sysinternals: www.sysintemals.com

File Edit Event EIUIE Tools Options Help

a |I_|I| rAa Enable Advanced Output i
il | [ i
Time ... Process Mam o]
3522, notepad ex Reset Filter Ctri+R
2522 | Inotepad.ex Load Filter 3
522 Gromede]  soveFiter. 2

3. Monitor a process:
a. Select Process Name, contains, and then type the name of suspicious process.
b. Click Add, Apply, and OK.
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B Process Menitor Filter x
input suspicious process name
Display entries matching these conditions: O
Process Name « (| contains VE v| then |Include L
Architecture is
Authentication |D is not 2
Category less than o i
Command Line more than
Company begins with Acti A
jon
Completion Time ends with
Date & Time contains ad Include
Description On exe Exclude
Detail Procexp exe Bxclude
Duration Autoruns exe Exclude
IE""EM cp!as; ProcmonG4. exe Exclude
o o Procexpbd exe
Imtegrity =
Operation . -
Parent PID
Path Cancel Apply
PID

Process Mame
Relative Time
Bariile

Heg'lllm-"f.ﬂ..le HKI_MREO WHHE\FMH‘\MMM\ -NN-'IE NOT FOUMND Le.-ngtl
f RegClosekey  HKLM\SOFTWARE'\Policies'\Microsoft'. . SUCCESS
Results for the process are displayed.
4. Review the process results:
You can check the API functions being used by the suspicious process. Depending on the type of malware, various
samples may indicate various suspicious API calls.
Common calls that might be considered suspicious include:
« Unpack/Decrypt - VirtualAlloc VirtualProtect RtiMoveMemory
« Ransomware - GetlLogicalDrives GetDriveType FindFirstFile FindNextFile EncryptFile
« Virus Infector - WriteFile SetFilePointer CreateFileMapping
« Process Injector - GetTempPath CreateFile CopyFile
« Backdoor - ReadFile WinHttpOpen
In the following example, the Operation column displays example processes for a test sample notepad application.

Time ... Process Name FID Operation Path Result Detail

6:32:4... ~Inotepad.exe 7780 ﬁﬂegﬂumh’.ﬂf HKC LI SUCCESS Query: HandlaTag.
6:32:4.. notapad_gxe 7780 RegOpenkey HKC L\Seftwane \Microsoft \Office’\16.0%. .. SUCCESS Desired Access: All...
6:32:4, nntepad axe 7730 s RegluenyValue HHKCUNSOFTWARE \Microsoft\Office’1... NAME NOT FOUND Length: 12

6:32:4. . nntapad_em T7el Hﬂeﬂumume HECUNSOFTWARE Microsoft \Office’.1... NAME NOT FOUMD Length: 144

6:324..  notepad.exe 7780 e Regliuery'/aue HKC UNSOFTWARE \Microsoft \Office’1... NAME NOT FOUND Length: 144

6:324.. not!pad axe 7780 '+ CreateFie C:\Users\ResearchDept\Desktop SUCCESS Desired Access: R...
6:32-4.. [ Unotepad.exe 7780 s QueryBasicinformationFile C:\Llsers'\ResearchDept'\Desktop SUCCESS Creation Time: 3/25...
6:32-4. "mnutepad axe 7780w CloseFile C:\UsersResearchDept'Deskiop SUCCESS

6:32:4.. nmmad_ﬂe 7780 ‘v CreateFie CA SUCCESS Desired Access: R
6324, Inotepad exe 7780 v QueryDirectory Cillsers SUCCESS FilelnformationClas
6:32:4 ,nntepad_exe TTE-{I EIHchqury HKLM SUCCESS Query: HandleTag. ..
6:32-4... Inotepad.exe s RegOpen ey HKLM\Softwane' Microzoft \Windows C... SUCCESS Desired Access: R.

5. Once you have confirmed the suspicious process, right-click the process, and select Properties to view the File

Path.
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i . i TCP T DESKTOP-MR3IKCA:57035 -> mediaro... SUCH
Properties..  Ctri+P [ Sm— C:\Windows\SysWOW64\KemelBase dil SUC(
B Stack.. Ctrl+K ¥ TCP Disca #-,
' RegClosel a2
H Teggle Bookmark Cirl+B  RegClosel
Jump To... Cirl+) :'Ihread Ex ﬁ Event d0h Process & Stack
Search Online.., FT"""“"-‘d Ex
.HEUDTJE"ll Image
Include ‘'wget.exe RegCpent
I g : 'HEI;SE‘IH"I - ._
Exclude ‘wyget.exe  RegQuery! |:
ight ' ' ' Regllosel
Sughllght waget.exe '{;lem;{}pml —
e
ot :ﬂﬁgﬂpml Version:
- . , RagSatin
Edit Filter ‘wget.exe  RegCuedl Path:
| RegClosel
Exclude Events Before Jﬁiad = | -
Exclude Events After P Process E I
' RegOpenl -
Include 3 :Hegl.}._ler;'
Fwrlurds 3 RegClosel

6. Note the file path, and use Windows Explorer to locate the suspicious file.
In Windows Explorer, add the suspicious file to a ZIP archive with the password: infected.

8. Attach the ZIP archive to the FortiCare ticket for the FortiCare team to analyze, or email to
submitvirus@fortinet.com.

N

Installing and using Autoruns to locate suspicious files

You can use the Autoruns utility to view all applications or programs within the host that automatically start.

An application or program that uses the autorun feature isn't necessarily suspicious. Some clean or legitimate
applications or programs can employ autorun. Nonetheless malware uses the autorun feature to ensure persistence
upon system reboot.

To install Autoruns:

1. Download Autoruns from Microsoft at https://docs.microsoft.com/en-us/sysinternals/downloads/autoruns.
2. Install Autoruns.
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To use Autoruns to locate suspicious files:

1. Open the Autoruns utility, and go to the Everything tab to view the Autoruns Entry list.

B Autoruns - Sysinternals: www.sysinternals.com

File Search Entry Options Categoery Help

EEIODLR Al AR |[Posme

& LSA Providers

ﬁ Evmhingﬂ " Explorer .E Internet Explorer Scheduled Tasks
Autoruns Entry Description

£ Logen
B HKCU\SOFTWARE\Microsoft\Windows\CurrentVersion\Run
£ MicrosoftEdgeAutoLaunch, Microsoft Edge
[] @ OneDrive Microsoft OneDrive

ﬁ HELM,SOFTWARE\Microsoft\ Windows\ CurrentVersion\Run

B HKLM\SYSTEM\CumentControlSet\Control\SafeBoot\AltemnateShell

[] @ cmd.exe Windows Command Processor
B HKLM\SOFTWARE\Microsoft\Active SetuphInstalled Components
Eﬂjﬁnogle Chrome Google Chrome Installer
E E.j Microsoft Edge Microsoft Edge Installer
M [ n/a Microsoft NET IE SECURITY REGISTRATION

B HKLM\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\Run

2. Search for any unusual, suspicious entries in the Autoruns Entry list.
A suspicious autorun entry can be any unfamiliar or unknown application or program that you or your system
administrator may not be aware of. Usually the entry in the list indicates the name of the application currently
running.

3. Ifyou cannot determine a suspicious entry in the Autoruns Entry list, save an Autoruns file:
a. Goto File > Save.

(Ve
Ve
(Ve

Autorun generates and saves a file with an .arn extension. The following example shows the DESKTOP-I.arn

file:

B Autoruns - Sysinternals: www . sysinternals, N 5 | Desktop

m Search Entry Options Categor_v“ e i i

& Run As Administrator '[
— « 4 M > ThisPC » Desktop
Er Open.. Ctri+0 @ Lsa
i Mame
n ~ 3 Quick access
desktop.int
Deskto -
- E | DESKTOP-1.am
Compare... % Downloads +
ndows\Ci B b
_} Refrech E5 E 1 __‘] ocuments .
Indows\C
Exit
™ rundrr
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4,

5.
6.

b. Attach the log text file to the FortiCare ticket.
c. Skip the remaining steps in the procedure.

If you locate a suspicious entry in the Autoruns Entry list, right click the process, and select Jump to Image.. to go to
the file location.

The following example shows how to use the Autoruns Entry list to locate a sample test file for Microsoft Edge.

B Autoruns - Syminternals: www.sysinternals.com

:i = | C\Program Files (x86)\Microsoft\Edge\Application
File Search Entry Options Category Help
Flll: Hame Share View
EEODLE A W Hes>
= L » This PC » Local Disk (C:) » Program Files (x86
[ KnownDLLs S WinLogon | -
B E - MName
verything B Logen m  Explorer e
Autoruns Entry B Desktop "
.D,Logun SetupMetrics
lr Downloads o’

S HKCU\SOFTWARE\Microsoft\Windows\CurrentVersion\Run ' _| delegated\WebFeatures.sced

= W e e 5 msedge.exe
Ctrl+D e S

£ % OneDirive [{[Ej zelete e &= Pictures # 2] msedgeVisualElementsManifestxml
i) HKLM\SOFTWARE\.MICI opy L n D Music 7] msedge_proxy exe
B | vBoxTray Jump to Entry (2] pwahelper exe
Ll asn L= ¢
@ HKLM\SYSTEM\ Curren = pates I Videos
1l cmd.exe | @ OneDrive

B HKLM\SOFTWARE\Mic
| Dﬁnogle Chrome
% E"}MICTQSUH Edge
n'a

¥ HKLM\SOFTWARE\Woy  Search Online... Ctr+M rrent
Pl . : Find... Ctrl+F

B HKLM\SOFTWARE\Won \nst:
R n/a D Properties... Alt=Enter

In Windows Explorer, add the suspicious file to a ZIP archive with the password: infected.

Attach the ZIP archive to the FortiCare ticket for the FortiCare team to analyze, or email to
submitvirus@fortinet.com.

Revealing hidden, suspicious files

Sometimes suspicious files are hidden from view in Windows Explorer. You can use this procedure to display hidden
files.

This procedure presumes that you have already identified the suspicious file or process.
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To reveal hidden, suspicious files:

1. PressWin+R, type cmd, and press Enter.

All Apps Documents Web

Best match

i Command Prompt
App

Search the web

L cmd - see web results

The Command Prompt window is displayed.

2. Atthe prompt, enterattrib -s -hfollowed bythe <File Path of Suspicious File>, and press Enter.
For example, enter attrib -s -h C:\suspicious\file.exe.

Bl Command Prompt

wrattribh —s —h cissuspicioussfile.exe

The file is unhidden.

3. In Windows Explorer, add the suspicious file to a ZIP archive with the password: infected.

4. Attach the ZIP archive to the FortiCare ticket for the FortiCare team to analyze, or email to
submitvirus@fortinet.com.

Ending tasks or killing running processes to enable copying of
suspicious files

When the suspicious sample file is locked by a running process, you cannot obtain the file. This topic describes how to
use the following tools to end the task or kill the running process, so you can copy the file.

» Windows Task Manager
o Process Explorer
« Resource Monitor

This procedure presumes that you have already identified the suspicious file or process.
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To end tasks or kill running processes:

1. Open Task Manager or Process Explorer.
2. Inthe list, search for the process that is using the file.
3. End orkill the process:
« Ifyou are using Task Manager, right-click the file, and select End Task.

B

File Options View

Processes Performance App history Startup Users De

Mame

S e S S e e e S =

Client Server Runtime Process

Bl Console Windma Hnet

i End task
Bl Console Win

Resource values ¥
(8] Desktop Win Provide feedback

Local Securit

Create dump file

LocalServicel Giito idetae

Registry Open file location
P Search online
Properties

Service Hostr.

Service Hnst: CantureService ?dabh
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« If you are using Process Explorer, right-click the file and select Kill Process.
&% Process Explorer - Sysinternals: www.sysinternals.com [DESKTOP-|

File Options View Process Find Users Help

d @ =0 =% &d [ L |

Process CPU  Private Bytes  Warking
0.02 96,428 K 141
22,496 K ¥a.

E 0.45 10,092 K 26.:
jnutepad.exe 0.01 J464 K 21
= =

[ conhost exe Window > Pt
= [z cmd exe Y.
[ conhost exe set Affinity... £
= Elcmd exe Set Priority > B
[ conhost exe :
= [z cmd exe Kill Process Del £
o= F
Bl Kill Process Tree Shift+Del £~
=)~ ¥ firefon.exe ]
(@ firefox exe Restart i
i@, firefox exe Suspend 3
{a firefox exe L

4. If you cannot find the suspicious process by using Windows Task Manager or Process Explorer, try using Resource
Monitor:
a. PresswWin+R, enter resmon, and press Enter to open Resource Monitor.

All Apps Documents Web More

Best match

@ resmon

Run command

S © resmon

The Resource Monitor window is displayed.
Go to the CPU tab.

c. Inthe Associated Handles section, enter the filename in the Search box, and press Enter.
The process is displayed.

d. Inthe Search Results list, right-click the process, and select End Process.
In the following example, a process called cmd.exe is ended.
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@ Resource Monitor
File Monitor Help
Overview ©CPU  Memory Disk  Metwork

Processes B 63 CPU Usage [7 100% Maximum Fregquency I;"
|:| Image PID Descrip... Status Threads CPU  Averag.. ™
|:| SearchApp.exe 5736 Search ... Suspe.. 65 0 0.00
|:| ShellExperienceHost. exe 7080 Windo... Suspe.. 21 o 0.00
|:| YourPhone. exe 5684 Suspe... 23 o 0.00
|:| SystemSettings.exe 9732 Settings Suspe.. 18 0 0.00
|:| Microsoft.Photos.exe 11460 Micros...  Suspe.. 16 0 0.00
|:| LockApp.exe 124338 Lockfp.. Suspe.. 12 0 0.00
|:| perfmon.exe 13420 Resour... Runni... 17 0 1.79
|:| Taskmgr.exe 7744 Task M... Runni... 14 1 073
[] dwm.exe 792 Deskto.. Runni... 22 0 0.48
Tlrs s R o : 490 n oo (R

Services

B 0 CPU Usage

Search Results for "cmd.exe”

£l

Image PID Type Handle Name

cmd.exe 3628 File C\Windows' System32hen-UShem...
cmd.exe 3636 File ChwindowshSystem32ien-USscm...
cmd.exe End P File ChwWindowshSystem32ien-USsom...
cmd.exe fOEEss File ChywWindowshSystem32ien-Usom...

5. In Windows Explorer, add the suspicious file to a ZIP archive with the password: infected.

6. Attach the ZIP archive to the FortiCare ticket for the FortiCare team to analyze, or email to
submitvirus@fortinet.com.
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Change Log

Date Change Description

2022-05-26 Initial release.
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